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Thank You for Choosing Ross
You've made a great choice. We expect you will be very happy with your purchase of Ross Technology. 

Our mission is to:

1. Provide a Superior Customer Experience

• offer the best product quality and support

2. Make Cool Practical Technology

• develop great products that customers love

Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and 
empowers our employees. I hope you enjoy reading it below.

If anything at all with your Ross experience does not live up to your expectations be sure to reach out to 
us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics
Any company is the sum total of the people that make things happen. At Ross, our employees are a 
special group. Our employees truly care about doing a great job and delivering a high quality customer 
experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our 
behavior:

1. We will always act in our customers’ best interest.

2. We will do our best to understand our customers’ requirements.

3. We will not ship crap.

4. We will be great to work with.

5. We will do something extra for our customers, as an apology, when something big goes wrong and 
it's our fault.

6. We will keep our promises.

7. We will treat the competition with respect.

8. We will cooperate with and help other friendly companies.

9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in 
times of company or customer crisis - do what you know in your heart is right. (You may rent 
helicopters if necessary.)
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Introduction
Thank you for purchasing the Ross Video RCP-NKQ Remote Control Panel. This remote control panel enables you 
to control a routing switcher system from one point. With Ross Video’s reputation for delivering leading-edge 
routing switcher equipment and our unsurpassed level of customer service and support, you can look forward to 
many years of reliable broadcasting. Please read this guide  thoroughly and retain it for future reference.

The RCP-NKQ provides flexible connectivity of additional remote control panels and multi-page menu 
programming.

Overview of this User Guide 

This  is for installers, and operators of the Ross Video RCP-NKQ, It provides instructions on how to connect the 
RCP-NKQ to your routing switcher system, how to set up a configuration document for the RCP-NKQ using 
DashBoard, and how to operate it. It assumes that you are experienced with general broadcast concepts, and that 
you are familiar with the planning requirements for a routing switcher system.
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RCP-NKQ Overview

Features

The RCP-NKQ Remote Control Panel provides the following features:

• 17 programmable keys (function, backlighting level, color, and custom text)

• operation in XY mode

• up to 32 router levels may be controlled

• virtual routing and resource management

• macros

• panel linking with other remote control panels

• support in DashBoard for easy creation of configuration documents

• firmware is fully upgradeable using DashBoard

• slim modular design integrates with NK Series devices via T-Bus using straight CAT5 Ethernet cables

• up to 250 pages of programmable menus including navigation keys

• assignable functions of destination, source, crosspoint, level, breakaway, breakaway step, macro, protect, take, 
chop, de-assign, machine control, panel lock, menu link, menu navigation, and menu display

Typical System Equipment

The RCP-NKQ is used when you require advanced control functions from a single point. Using DashBoard, you 
can program up to 250 menus on the same remote control panel. At each menu, the function of particular keys may 
change depending on the assignment. These parameters can be saved in a configuration document and sent to an 
RCP-NKQ at any time using DashBoard. Therefore, if an RCP-NKQ is used in a number of different operating 
scenarios, the configuration can be changed easily and quickly.

Typical equipment that is used in an NK Series routing switcher system when an RCP-NKQ is used includes:

• any of the NK Series routing switchers with its appropriate power supply (for more information see the 
documentation provided with your NK Series routing switcher)

• an NK-IPS Network Bridge

• a PC running DashBoard, connected via a CAT5 Ethernet cable to the NK-IPS

• standard source and destination equipment (for example, cameras, VTRs, servers)

Before You Begin
• If you are connecting the PC directly to the NK-IPS, use a crossover CAT5 Ethernet cable.

• If you are connecting the PC indirectly via an Ethernet switch to the NK-IPS, use a straight-through CAT5 
Ethernet cable.

• The NK-IPS and PC with DashBoard are only required for setting up the configuration document, then sending 
this to the device. However, you can use the NK Switchboard feature in DashBoard to control and monitor a 
routing switcher system.

System Overview

A routing switcher system may use distributed control across the internet, a LAN, or a VPN. The routing switcher 
system shown in Figure 2.1 has been simplified.
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Figure 2.1  Layout showing a simplified routing switcher system with an RCP-NKQ

 All T-Bus connections between NK Series devices use straight-through CAT5 cables.
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How the RCP-NKQ and Routing Switchers Communicate

Switching

The RCP-NKQ sends a switch request message to the routing switcher. The routing switcher recognizes the request, 
sets the crosspoint, then sends a response to the RCP-NKQ.

Data Storage

The RCP-NKQ stores information on the menu, destination, level, breakaway, and machine control status. The 
routing switcher stores the crosspoint status in its internal memory.

When the routing switcher system is powered up, the routing switcher restores its crosspoint status. The RCP-NKQ 

requests the status of the routing switcher. The routing switcher sends the status of the crosspoints to the 
RCP-NKQ.
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Installation

Unpacking the Equipment

On receiving your RCP-NKQ, check the contents against the packing list. Make sure that all equipment itemized on 
the packing list is present and that there are no signs of damage before you start installing the RCP-NKQ into your 
system.

If anything is missing or damaged, contact your Ross Video office immediately to obtain the correct warranty 
service procedures. This ensures prompt assistance, minimal turnaround time, and avoids any freight issues.

We recommend that the equipment is installed by qualified and experienced personnel, to any relevant standards 
and approvals.

General

These installation guidelines assume the following:

• The relevant NK Series equipment has been installed into a ventilated rack frame. The relative humidity in the 
environment of the equipment should be < 70% (non-condensing).

• The routing switcher system has been well planned and designed. Consideration must be given to inputs and 
outputs across multiple router levels, and typical operating scenarios for breakaways.

• Correct IP addresses have been assigned to the equipment, where required.

• The routing switchers are connected to physical inputs and outputs, and have appropriate NK Series power 
supplies.

• All NK Series equipment connected in the routing switcher system have firmware v2.00 or later. For information 
on updating the firmware in a device see the readme file that comes with the firmware. To check for the latest 
firmware versions, contact Ross Video Technical Support.

Installing the RCP-NKQ

The RCP-NKQ is powered using the 5 V 2 A power supply provided. This power supply connects directly to the 
AC mains supply.     

Installing the Routing Switcher System in a Daisy-Chain Layout

You may connect NK Series equipment in a daisy-chain layout. The items are connected via the T-Bus control 
system. However, if the T-Bus chain is broken, for example, by accidentally disconnecting a cable, downstream 
devices are also disconnected. T-Bus RJ-45 sockets on devices downstream from the NK-IPS are passively 
connected internally, so device failure or power disconnection does not disrupt communication with other devices 
in the chain.

Each T-Bus connector on the NK-IPS has an independent driver/receiver ensuring that each of the eight T-Bus 
connectors will not be affected by a device failure on any other connector.

Warning — Ensure that the AC mains supply complies with the PSU specification before making the 
connection.

Warning — An earthed neutral mains supply and residual current device is recommended for safe 
operation.
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Figure 3.2  Remote control panels connected to NK Series Equipment in a daisy-chain layout

To connect the remote control panel in a daisy-chain layout

1. Install the RCP-NKQ into the rack frame, then fix in place with appropriate fasteners.

2. Connect a straight-through CAT5 Ethernet cable between a T-Bus connector on the rear of the RCP-NKQ and 
a T-Bus connector on the rear of another remote control panel, an NK Series routing switcher, or an NK-IPS 
(see Figure 3.2).

If required, make a similar connection between the remaining T-Bus connector on the rear panel of the 
RCP-NKQ and a T-Bus connector on the rear panel of another item of NK Series equipment.

3. Connect the 5 V 2 A power supply provided to the POWER connector on the rear panels of the RCP-NKQ.

4. Connect the cable from the power supply to a suitable AC mains supply.

 The RCP-NKQ is designed for installation into a standard 19" equipment rack. It has integrated rack ears, 
allowing it to be screwed in using standard screws and cage nuts.

Installing the Routing Switcher System in a Star-Layout

You may connect NK Series equipment to the NK-IPS in a star layout. The items are connected via the T-Bus 
control system. If any device connected directly to the NK-IPS is disconnected, it is only the downstream devices 
that become non-operational. All other devices remain operational.

NK-IPS
Network Bridge

RCP-NKQ
Remote Control Panel

RCP-NKQ
Remote Control Panel

Routing Switcher

Appropriate
NK Series

power supply

T-BUS

T-BUS

T-BUS

Appropriate
NK Series

power supply

NK Series
5 V, 2 A

powersupply

NK Series
5 V, 2 A

powersupply



RCP-NKQ User Guide (v3.0) Installation • 3–3

Figure 3.3  Remote control panels connected to NK Series equipment in a star layout

To connect the remote control panel in a star layout

1. Install the RCP-NKQ into the rack frame, then fix in place with appropriate fasteners.

2. Connect a straight CAT5 Ethernet cable between a T-Bus connector on the rear panel of the RCP-NKQ and a 
T-Bus connector on the rear panel of the NK-IPS (see Figure 3.3).

3. Connect the 5 V 2 A power supply provided to the POWER connector on the rear panel of the RCP-NKQ.

4. Connect the cable from the power supply to a suitable AC mains supply.

5. Connect any remaining remote control panels in this manner.

 The RCP-NKQ is designed for installation into a standard 19" equipment rack. It has integrated rack ears, 
allowing it to be screwed in using standard screws and cage nuts.

Connecting to the NK-IPS in the Routing Switcher System

Before you can set up and send a configuration document to the RCP-NKQ, you must connect an NK-IPS to the 
RCP-NKQ. Once DashBoard locates the NK-IPS, the attached RCP-NKQ is visible and can have configuration 
documents sent to it.

Most systems automatically detect an NK-IPS if its IP address uses the same subnet as the PC running DashBoard. 
However, if the device is not detected automatically, follow the steps below. For information on the NK-IPS, refer 
to the documentation provided with the equipment.

To connect to the NK-IPS

1. Launch DashBoard.

2. Use Walkabout to determine and/or change the IP address of the NK-IPS. Refer to the NK-IPS User Guide for 
more information.

3. From the main toolbar in DashBoard select File > New > NK IPS Connection.
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4. Enter the IP Address of the NK-IPS you want to connect to.

5. Ensure the TCP Port field is set to 5000.

6. Click Finish.

The NK-IPS now displays as a node in the Basic Tree View of DashBoard.

Checking the Firmware Version of a Device

The RCP-NKQ must operate with other devices that have v2.00 firmware or later. Firmware may be updated easily 
using DashBoard. To check for the latest firmware versions, contact Ross Video Technical Support.

Using DashBoard to Check the Firmware Version

To check the firmware version of any device using DashBoard

1. Launch DashBoard and connect to the NK-IPS.

2. In the Device Tree of DashBoard, expand the NK-IPS (or NK-NET) node to display a list of sub-nodes.

 Each sub-node is a list of devices communicating with the NK-IPS (or NK-NET).

3. Double-click the RCP-NKQ node to open its interface in DashBoard.

The firmware version is reported in the top panel of the window.

Upgrading the Firmware Version of a Device

For information on upgrading the firmware version of a device, see the readme file that comes with the firmware.
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Setting Up the RCP-NKQ
The RCP-NKQ can be set up using DashBoard. You must have an NK-IPS connected into the system. The 
parameters for a device may be then saved to a configuration document.

For More Information on...

• checking and upgrading firmware see “Using DashBoard to Check the Firmware Version” on page 3–4 and 
“Upgrading the Firmware Version of a Device” on page 3–4.

• saving parameters to a configuration document, see “Saving the Current Document for the RCP-NKQ” on 
page 4–24.

Opening the RCP-NKQ Editor

 Before setting up any parameters for the RCP-NKQ, ensure that all NK Series devices in the routing switcher 
system have firmware v2.00 or later. 

To open the RCP-NKQ editor

1. Launch DashBoard and connect to the NK-IPS.

2. In the Device Tree of DashBoard, expand the NK-IPS (or NK-NET) node to display a list of sub-nodes.

 Each sub-node is a list of devices communicating with the NK-IPS (or NK-NET).

3. Double-click the RCP-NKQ node to open its interface in DashBoard.
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Implementing Your System Plan

An effective routing switcher system takes careful planning. If you intend to use multiple router levels across 
several input and output devices, it is recommended that you use common input connectors for each source device 
across the routing switchers, and common output connectors for each destination device across the routing 
switchers. Th e recommended methodology for setting up the RCP-NKQ is shown in Figure 4.4.

Figure 4.4  Flow chart for setting up the RCP-NKQ

Viewing and Changing Device Details

When a device attached to the NK-IPS is interrogated, a tab for the device appears in the main pane of DashBoard 
(see Figure 4.4). Information is read from the device and shown in the simulated RCP-NKQ.

To view the details for the RCP-NKQ

1. Open the RCP-NKQ editor (see “Opening the RCP-NKQ Editor” on page 4–1).

The read-only parameters for the RCP-NKQ are shown in the top section of the tab of the device.
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To change the details for the RCP-NKQ

1. In the Device Details frame, click in the field that you want to change.

2. Enter the information as required (see Table 4.1), then press Enter.

3. Send the current document to the device by clicking Send Configuration located on the lower Device 
Configuration window (see “Sending a Document to a Device” on page 4–24).

 You should save the current document regularly (see “Saving the Current Document for the RCP-NKQ” on 
page 4–24).

Default Configuration

Every NK Series device leaves the factory with a default configuration. This default configuration is viewed by 
opening the editor for the device in DashBoard.

Loading Default Configuration and Factory Defaults

If you have made changes to the configuration, but want to return to the default configuration, you can send the 
default document to the device (see “Sending a Document to a Device” on page 4–24). You can also load the 
factory defaults (see “Loading the Factory Defaults” on page 4–23).

Table 4.1  Device details that are read from the RCP-NKQ

Item Description

Serial Num (read-only) This parameter is read-only. The serial number of the device. This is set in the factory. It is 
unique to the device.

If you are working on a file that is stored under File Explorer, the serial number of the 
device is replaced by SAVED-FILE.

Version (read-only) This parameter is read-only. The version status of the firmware detected in the device.

If the firmware version for any NK Series device that is connected to the RCP-NKQ is 
earlier than v2.00, you must upgrade the firmware in that device (see “Upgrading the 
Firmware Version of a Device” on page 3–4).

Name (user definable) The name for the device. The default name for the RCP-NKQ is Default - NKQ. This 
parameter may be changed to any name that uniquely identifies the device, for example, 
RCP-NKQ. The name may be up to 16 characters in length.

Group (user definable) The group to which the device belongs. This parameter is used to identify items of 
equipment that may be in the same location or used for a similar purpose, for example, 
equipment in the same rack, or a logical grouping of modules that may be operated as a 
group. The group identifier may be up to 10 digits in length.

Details (user definable) The meaningful details of the device. This parameter is used to specifically identify this 
device from other devices, for example, OBV Rack 1. The details may be up to 
16 characters in length.

Address (user definable) The address is used by each device in the routing switcher system to identify itself to other 
devices during communication. The default address for an RCP-NKQ is the last two digits 
of the serial number, plus 100. Devices should have a unique address.

If you want to link a number of similar remote control panels together so that they function 
as one remote control panel, set the same address for each remote control panel, then set 
individual panel link addresses for each remote control panel (see “Linking Remote 
Control Panels” on page 4–4).
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Router Levels

The RCP-NKQ sends switch requests to the routing switcher. Each routing switcher is assigned a level, or number 
of levels if it has been partitioned. These level assignments may be changed through the configuration editor for the 
routing switcher in DashBoard.

Breakaways

The default breakaway is tied, that is, the first eight router levels are switched together when requested from the 
RCP-NKQ. If your routing switcher system does not use all of the router levels stated above, you should remove the 
unused levels from the default breakaway. For more information on breakaways see “Setting Up Breakaways” on 
page 4–6.

Key Assignments

By default, the RCP-NKQ has these key assignments:

• keys 1 to 6: destinations (outputs 1 to 6 respectively)

• keys 7 to 13: sources (inputs 1 to 7 respectively)

• key 14: Level 1 (MD)

• key 15: Macro 1

• key 16: Menu 1

• key 17: Menu 2

Figure 4.5  Default key assignments on the Home menu

Linking Remote Control Panels

If your routing switcher system is extensive, control of the entire system may not be possible through just one 
remote control panel. If this is the case, additional remote control panels may be added, as described  “Installing 
the RCP-NKQ” on page 3–1. You can choose to operate the remote control panels individually, or you can link the 
remote control panels together so that they operate as one larger remote control panel. For more information see 
“Operating Linked Remote Control Panels” on page 5–6.

You may link RCP-NKM and RCP-NKQ remote control panels together. You cannot link the RCP-NK1 with a 
RCP-NKM or RCP-NKQ.

Table 4.2  Default Router Levels

Router Level Name

1 Multi-definition 3G/HD/SD SDI 
digital video

2 SD SDI digital video

3 AES/EBU digital audio 1

4 AES/EBU digital audio 2

5 Analog video

6 Analog audio (left)

7 Analog audio (right)

8 Machine control
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You may link up to 255 remote control panels together. When multiple remote control panels are linked, the 
Address field must be the same for all linked remote control panels, and the Panel Link Address field must be 
different for each remote control panel.

To link remote control panels together

1. Open the RCP-NKQ editor (see “Opening the RCP-NKQ Editor” on page 4–1).

2. In the Device Details frame, Address field, enter the common address (between 2 and 255) that you want all 
the linked remote control panels to use.

By default, the address is set to the last two digits of the serial number, plus 100.

3. Select the Configuration tab.

4. In the Panel Link frame, Panel Link Address field, enter the individual address (between 1 and 254) that you 
want this particular remote control panel to use.

By default, the panel link address of a remote control panel is set to zero (0).

5. Send the current document to the device by clicking Send Configuration located on the lower Device 
Configuration window (see “Sending a Document to a Device” on page 4–24).

6. Repeat this process for all of the remote control panels that you want to link together.

 The panel address and link address must be different for each remote control panel.

Assigning Physical Connections for Control by an RCP-NKQ

Source and destination equipment is physically connected to routing switchers. This connection information must 
be displayed meaningfully on the RCP-NKQ. This information is set up on the Input Assigns and Output Assigns 
tabs.

Selecting the Number of Inputs/Outputs

Depending on the size of the routing switchers connected, you may choose to increase or reduce the number of 
input and output labels to match the size of the routing switcher, if virtual routing is not used. The number may be 
changed in increments of 8.

To change the number of possible inputs and outputs

1. Open the RCP-NKQ editor (see “Opening the RCP-NKQ Editor” on page 4–1).

2. Do one of the following:

• To change the number of inputs, select the Input Assigns tab.

• To change the number of outputs, select the Output Assigns tab.

3. Use the up and down arrows in the Number of inputs/Number of outputs field to adjust the number to match 
the requirements of your routing switcher system.

4. Click Update.

5. If you want to transfer this number of inputs/outputs to the other tab, click Copy to Output Assigns/Copy to 
Input Assigns.

The labels are also copied.

6. Send the current document to the device by clicking Send Configuration located on the lower Device 
Configuration window (see “Sending a Document to a Device” on page 4–24).
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Assigning Input and Output Labels

To assign input and output labels

1. Open the RCP-NKQ editor (see “Opening the RCP-NKQ Editor” on page 4–1).

2. Do one of the following:

• To change the label for an input, select the Input Assigns tab.

• To change the label for an output, select the Output Assigns tab.

3. Double-click to highlight the text in the field corresponding to the input/output to which the item of 
source/destination equipment is connected.

4. Enter the name of the item of source/destination equipment.

5. Press Enter.

The name of the item of source/destination equipment appears on the corresponding key on the simulated 
RCP-NKQ in DashBoard.

6. Repeat this process until all of the inputs and outputs on the routing switchers have been assigned a label for 
the connected items of source and destination equipment.

7. If you want to transfer the labels for the inputs/outputs to the other tab, click Copy to Output Assigns/Copy to 
Input Assigns.

The number of inputs/outputs is also copied.

8. Send the current document to the device by clicking Send Configuration located on the lower Device 
Configuration window (see “Sending a Document to a Device” on page 4–24).

 If there are various router levels using this input or output number, then the label may be ambiguous if the source 
or destination is different for those levels.

 You may rearrange the layout of the labels on the keys when you assign functions to the keys (see “Assigning 
Functions to Keys on the RCP-NKQ” on page 4–9).

Setting Up Breakaways

A breakaway selects a group of levels to be switched. The default breakaway for the RCP-NKQ is the first eight 
router levels switching together, that is, tied. If your routing switcher system does not use all of the pre-defined 
router levels (see Table 4.2), you should disable those levels that are not used in order to prevent a breakaway 
warning. If you want to switch certain router levels only, set up a custom breakaway for these levels, then assign 
this to a key on the RCP-NKQ (see “Assigning Functions to Keys on the RCP-NKQ” on page 4–9). If you select 
a breakaway that includes a level for which there is no routing switcher assigned, a breakaway warning is indicated 
in the bottom right corner of the key.

To set up the breakaways

1. Open the RCP-NKQ editor (see “Opening the RCP-NKQ Editor” on page 4–1).

2. Select the Configuration tab.

3. Scroll to the Breakaways frame.

4. In the Tied level mask, de-select the router levels that are not used in your routing switcher system by clicking 
on the numbered squares.

A selected router level is indicated by a blue square.

For example, if router levels 2 and 3 are the only levels used, you should de-select levels 1, 4, 5, 6, 7, and 8 in 
the Level Mask column corresponding to Tied.

5. Double-click in the field below Tied in the Name column.

6. Enter the name of the router level that corresponds to the first custom breakaway that you want to define.
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For example, enter SDI.

7. Select the corresponding router level(s) in the Level Mask column (see Table 4.2), and de-select any router 
levels that are not used.

8. Define the next custom breakaway in the Name column below the breakaways that you have defined 
previously. Continue until you have defined all the custom breakaways that you want to use.

9. Clear the remaining level masks from unused breakaways in the Breakaways table.

10. Scroll to the Configuration frame.

11. Click the down arrow in the Breakaway Warning Mode field, then select the breakaway with which you want 
to compare the status of the router levels in the current breakaway.

12. Send the current document to the device by clicking Send Configuration located on the lower Device 
Configuration window.

Notes

Keep the following in mind when setting up breakaways:

• If you click and drag across the level mask, you can rapidly select or de-select router levels.

• The breakaway defined in the first row of the Breakaway table is the default breakaway.

• You can combine more than one router level in the same breakaway. Give the breakaway a meaningful name that 
covers the router levels that you want to use. Limit the name to 8 characters.

• A breakaway warning is caused by no response from the routing switcher system on one or more router levels or 
a difference in status of any level in the currently selected breakaway when compared with the first level in the 
breakaway.

• The default breakaway and any custom breakaways may now be assigned to keys on the RCP-NKQ.

For More Information on...

• sending the current document to the device, see “Sending a Document to a Device” on page 4–24.

• assigning breakaways to keys, see “Assigning a Breakaway to a Key” on page 4–13.

Resetting a Custom Breakaway to the Default Breakaway Automatically After a Switch

The default breakaway is defined in the first row of the Breakaways table in the Breakaways frame. Typically, this 
breakaway is tied, and switches all router levels together. If you want only certain router levels to switch, as defined 
in a custom breakaway, you select that breakaway on the RCP-NKQ, then make the switch. The RCP-NKQ 
continues to use that breakaway (as indicated by the key being illuminated) for all further switches until another 
custom breakaway, or the default breakaway is selected. If you want the RCP-NKQ to reset to the default 
breakaway immediately after a custom breakaway is used during a switch, then you should set the RCP-NKQ to 
reset the breakaway.

To enable the resetting of the breakaway to the default breakaway automatically after a switch

1. Open the RCP-NKQ editor (see “Opening the RCP-NKQ Editor” on page 4–1).

2. Select the Configuration tab.

3. Scroll to the Configuration frame.

4. Select the Breakaway Reset check box.

5. Send the current document to the device by clicking Send Configuration located on the lower Device 
Configuration window (see “Sending a Document to a Device” on page 4–24).

Setting Up Menus

Menus may be used to group certain functionality within the RCP-NKQ together. You can store up to 250 menu 
pages in the RCP-NKQ. You can also set up what happens after an activity has been performed in a particular menu, 
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that is, you can define the fallback. Each menu page provides a new set of 17 keys that you may assign with new 
functions.

For example, if you set up a menu containing all the breakaways, another menu containing all the destinations, and 
another menu containing all the sources, you can set up the menus so that once you have selected a breakaway, the 
menu containing all the destinations is shown so that you can select a particular destination device. Following this, 
the menu containing all the sources is shown so that you can select a particular source device.

To set up a menu

1. Open the RCP-NKQ editor (see “Opening the RCP-NKQ Editor” on page 4–1).

2. Select the Menu Details tab.

3. Use the up and down arrows in the Number of menus field to adjust the number to match the requirements of 
your routing switcher system.

4. Click Update.

5. In the row corresponding to Menu Number 1:

a. Double-click to highlight the text in the Menu Name column, enter up to 8 characters as a meaningful 
name for the menu, then press Enter.

b. Click in the Fallback Mode column, then select the option that you want from the drop list. Use the 
information in Table 4.3 as a guide.

If you have selected Specified Menu, enter the menu number in the corresponding field in the Fallback 
Menu column.

c. Click in the Menu Color column, then select the color that you want for the key.

6. Define the next menu in the Menu Name column below the menus that you have defined previously. Continue 
until you have defined all of the menus that you want to use.

7. Send the current document to the device by clicking Send Configuration located on the lower Device 
Configuration window (see “Sending a Document to a Device” on page 4–24).

Table 4.3  Fallback Mode Options

Option Function

Fallback Off After a key in the menu is pressed, the RCP-NKQ remains on the menu.

If you select Fallback Off, the corresponding value in the Fallback 
Menu column is ignored. You must provide extra menu navigation keys 
within the menu so that you can exit from the menu.

First Menu After a key in the menu is pressed, the RCP-NKQ returns to the menu 
set in Menu Number 1.

If the key that is pressed is assigned as a menu link or a menu navigation 
key, then the RCP-NKQ goes to that menu.

Previous Menu After a key in the menu is pressed, the RCP-NKQ returns to the menu 
that is was on prior to the current menu.

If the key that is pressed is assigned as a menu link or a menu navigation 
key, then the RCP-NKQ goes to that menu.

Specified Menu After a key in the menu is pressed, the RCP-NKQ returns to the menu 
specified in the corresponding field in the Fallback Menu column.

If the key that is pressed is assigned as a menu link or a menu navigation 
key, then the RCP-NKQ goes to that menu.
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Setting Up Display Options for Each Type of Key on the RCP-NKQ

You can set up the display options for each type of key on the RCP-NKQ so that you can distinguish between what 
type of function the key has, and whether or not the key is active. When a key is active, it shows the color and invert 
settings for the selected state. When a key is not active, it shows the color and invert settings for the default state.

You can select any of the available colors to represent default and selected states. You can also choose whether or 
not the default or selected state uses inverse.

Figure 4.6  Display options for keys on the RCP-NKQ

To set the display options for a key type

1. Open the RCP-NKQ editor (see “Opening the RCP-NKQ Editor” on page 4–1).

2. Select the Display Options tab.

The information in Table 4.4 describes the options that can be selected on the Display Options tab.

3. If you want to change the default color for a key type, click the corresponding down arrow in the Default 
Color column. As you make changes to the default and selected colors, the changes are shown immediately in 
the preview keys to the right of the Display Options table.

4. Select the color that you want the key to be when it is not selected.

5. If you want the text on the key to appear in inverse, select the corresponding check box in the Invert Default 
column.

6. Select the color that you want the key to be when it is selected.

7. If you want the text on the key to appear in inverse, select the corresponding check box in the Invert Selected 
column.

8. Send the current document to the device by clicking Send Configuration located on the lower Device 
Configuration window (see “Sending a Document to a Device” on page 4–24).

Assigning Functions to Keys on the RCP-NKQ

The RCP-NKQ is programmed in the factory with default key assignments (see “Default Configuration” on 
page 4–3). If this default key assignment is not suitable for your routing switcher system, you can easily customise 
the configuration using the DashBoard and save it as a document.

Table 4.4  Display Options

Column Description

Mode The type of function assigned to the key.

Default Color The color of the key when it is not selected or not active.

Invert Default The text on the key is shown in inverse when the key is not selected or not 
active.

Selected Color The color of the key when it is selected and active.

Invert Selected The text on the key is shown in inverse when the key is selected and active.

Default (not selected), inverted

Default (not selected), not inverted

Selected, not inverted

Selected, inverted
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The available functions are listed in the Properties pane, Function field drop list.

The RCP-NKQ may be programmed with 250 menu pages. Each menu may hold a different set of key functions. 
You can assign any of the following key functions across any menu.

Table 4.5  Functions that may be assigned to keys on the RCP-NKQ 

Function Description

Destination 
(Dest)

The item of destination equipment that receives the physical output from the routing 
switcher. The destination is selected by pressing the key, but the switch is not made until the 
required source key is pressed. For more information, see “Assigning a Source or 
Destination to a Key” on page 4–11.

By default, keys 1 to 6 on the RCP-NKQ are assigned as destinations.

Source The item of source equipment that sends the physical input to the routing switcher. A switch 
occurs when a source key is pressed, and the signal is routed to the currently selected 
destination. For more information, see “Assigning a Source or Destination to a Key” on 
page 4–11.

The function of any source key on a menu is changed when a TAKE key is assigned to the 
menu (see Take).

By default, keys 7 to 13 on the RCP-NKQ are assigned as sources.

Crosspoint
(Xpoint)

A breakaway, destination, and source assigned to one key. A switch is achieved by pressing 
the crosspoint key, rather than pressing a breakaway key, a destination key, then a source 
key. For more information, see “Assigning a Crosspoint to a Key” on page 4–12.

The function of any crosspoint key on a menu is changed when a TAKE key is assigned to 
the menu (see Take).

Level A specific router level assigned to a key. Pressing a level key, selects that router level. 
Multiple levels may be selected. If a switch is made while a level key is pressed, the switch 
is made on that router level only. For more information, see “Assigning a Level to a Key” 
on page 4–12.

Breakaway A pre-defined group of router levels assigned to a key. You select a breakaway as part of 
making a switch. For more information see, “Setting Up Breakaways” on page 4–6 and 
“Assigning a Breakaway to a Key” on page 4–13.

If a level key is assigned for one or all of the router levels in a breakaway, then the level keys 
corresponding to the router levels in the breakaway are illuminated when the breakaway key 
is selected. The level keys do not illuminate when the default breakaway is selected.

If you want to view the levels used in the current breakaway, hold the breakaway key (see 
“Viewing the Breakaways Assigned to an RCP-NKQ” on page 5–2). For help with 
reading the levels from the hexadecimal expression, see Table 7.12.

Breakaway Step
(Brk Step)

A single key that selects the next breakaway in the Breakaway table (see “Setting Up 
Breakaways” on page 4–6). For more information, see “Assigning a Breakaway Step Key” 
on page 4–13.

If you want to view the levels used in the current breakaway, hold the breakaway step key 
(see “Viewing the Breakaways Assigned to an RCP-NKQ” on page 5–2). For help with 
reading the levels from the hexadecimal expression, see Table 7.12.

Macro A sequence of switching events that are assigned to a key. For more information, see 
“Assigning a Macro to a Key” on page 4–13.

Protect A single key that places a block on the current destination, preventing its use by other 
sources, and other linked remote control panels. For more information, see “Assigning a 
Protect Key” on page 4–16.

The protect key may also be used to lock the RCP-NKQ (see “Locking the RCP-NKQ” on 
page 5–4).
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Assigning a Source or Destination to a Key

Source and destination keys map the physical connections on the routing switcher to the RCP-NKQ. You can 
provide meaningful labels for these physical connections using the Input Assigns and Output Assigns tabs for the 
RCP-NKQ (see “Assigning Physical Connections for Control by an RCP-NKQ” on page 4–5).

To assign a source or destination to a key

1. Open the RCP-NKQ editor (see “Opening the RCP-NKQ Editor” on page 4–1).

2. On the simulated RCP-NKQ, select the key that you want to use for the source or destination.

3. In the pop-up dialog:

Take The trigger that ends a hold on a switch sequence. This enables you to press the required 
breakaway, destination, then source key combination, or crosspoint key, or macro key, but 
not activate the switch until TAKE is pressed. If you have a TAKE key assigned on a menu, 
it affects the behavior of the menu. You must use it to activate any switch that is set up. If 
you do not have a TAKE key assigned to the menu, then a switch is made as soon as the 
source/crosspoint/macro key is pressed. For more information, see “Assigning a Take Key” 
on page 4–17.

Chop A single key that starts a slow or fast toggle between the two most recently selected sources 
for a given destination. For more information, see “Assigning a Chop Key” on page 4–17.

De-assign The DE-ASIGN button has two-fold functionality:

• A single key that provides a convenient method for disconnecting machine control ports. 
For more information, see “Setting Up Machine Control” on page 4–21.

• A single key that allows you to free-up resources when they are no longer needed for a 
path. For more information, see “Setting Up Virtual Routing and Resource 
Management” on page 4–22.

Machine Control Key 
(MC Key)

A single key that provides a convenient method for toggling reciprocal switching on and off 
when machine control is used. For more information, see “Setting Up Machine Control” on 
page 4–21.

Panel Lock A single key that provides a convenient method for locking the RCP-NKQ against accidental 
changes. For more information, see “Assigning a Panel Lock Key” on page 4–18.

The panel lock function may also be set using the Panel Locked check box on the 
Configuration tab.

Menu Link A link that accesses a pre-defined menu via a single key. For more information, see “Setting 
Up Menus” on page 4–7 and “Assigning a Menu Link to a Key” on page 4–18.

Menu Navigation A specific menu destination assigned to a key. You can set the key to return to Menu 
Number 1 (Home), the next or previously visited menu, or go up or down a menu as defined 
on the Menu Details tab. If XPoint Layer is selected, you can cycle through the current 
breakaway, destination and source on any visible crosspoint keys by repeatedly pressing this 
navigation key. The navigation key shows the current layer. For more information, see 
“Assigning Menu Navigation to a Key” on page 4–19.

Menu Display A status report that is displayed on a key. For example, if you choose to display the current 
output, then this key shows the output label for the currently selected destination. For more 
information see “Assigning a Menu Display to a Key” on page 4–19.

Unassigned A label indicating that the key does not have any of the above key functions assigned to it, 
and therefore does nothing when pressed. For more information, see “Unassigning a Key” 
on page 4–20.

Table 4.5  Functions that may be assigned to keys on the RCP-NKQ  (Continued)

Function Description
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a. Select the key function type.

b. Select the desired key value.

The simulated RCP-NKQ in DashBoard shows the label for the specified input/output on the selected key. If 
you have assigned a name to this input/output using the Input Assigns/Output Assigns tab, this name appears 
on the key.

4. Send the current document to the device by clicking Send Configuration located on the lower Device 
Configuration window (see “Sending a Document to a Device” on page 4–24).

 If you have virtual routing enabled in the RCP-NKQ, the output that you enter represents the virtual destination 
as set up in the NK-VRC Virtual Routing Core.

Assigning a Crosspoint to a Key

When you make a switch, you need to select the level(s) that you are switching using a breakaway, the destination, 
then the source. This requires three key presses. To reduce this effort and the potential for error, common switch 
sequences may be set up in a crosspoint.

 You should also assign a menu navigation key on the same menu as a crosspoint key. Set the menu navigation 
key to XPoint Layer. This key may be used to toggle through the breakaway, destination and source information 
in the crosspoint.

To assign a crosspoint to a key

1. Open the RCP-NKQ editor (see “Opening the RCP-NKQ Editor” on page 4–1).

2. On the simulated RCP-NKQ, select the key that you want to use for the crosspoint.

3. In the pop-up dialog:

a. Select Crosspoint as the key type.

b. In the Output field, enter the physical output that connects to the item of destination equipment to which 
you want to switch, then press Enter.

c. In the Input field, enter the physical input that connects to the item of source equipment that provides the 
required signal, then press Enter.

d. In the Breakaway field, enter the breakaway level that you want to use for the switch, then press Enter.

The simulated RCP-NKQ in DashBoard shows the name of the source and crosspoint indicator on the selected 
key.

4. Send the current document to the device by clicking Send Configuration located on the lower Device 
Configuration window (see “Sending a Document to a Device” on page 4–24).

Assigning a Level to a Key

A level key enables you to select one router level for a switch. While a breakaway is similar, it may contain more 
than one router level.

To assign a level to a key

1. Open the RCP-NKQ editor (see “Opening the RCP-NKQ Editor” on page 4–1).

2. On the simulated RCP-NKQ, select the key that you want to use for the level.

3. In the pop-up dialog:

a. Select Level as the key type.

b. In the Level Value field, enter the specific router level that you want to assign to this key, then press Enter.

The simulated RCP-NKQ in DashBoard shows the selected level on the key, for example Level 2.
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4. Send the current document to the device by clicking Send Configuration located on the lower Device 
Configuration window (see “Sending a Document to a Device” on page 4–24).

Assigning a Breakaway to a Key

When you make a switch, you need to select the level or levels that you are switching using a breakaway. The 
breakaways should be set up before they are assigned to a key (see “Setting Up Breakaways” on page 4–6).

To assign a breakaway to a key

1. Open the RCP-NKQ editor (see “Opening the RCP-NKQ Editor” on page 4–1).

2. On the simulated RCP-NKQ, select the key that you want to use for the breakaway.

3. In the pop-up dialog:

a. Select Breakaway as the key type.

b. In the Breakaway value field, enter the row number for the breakaway that you want to use, then press 
Enter.

The simulated RCP-NKQ in DashBoard shows the name of the breakaway on the selected key, for example, 
Tied.

4. Send the current document to the device by clicking Send Configuration located on the lower Device 
Configuration window (see “Sending a Document to a Device” on page 4–24).

Assigning a Breakaway Step Key

An RCP-NKQ may have several breakaways defined. If you want to cycle through the breakaways that have a 
non-zero level mask, assign a breakaway step key to the RCP-NKQ. The breakaway step key shows the name of the 
currently selected breakaway with the breakaway step indicator. If you hold the breakaway step key for each 
breakaway, the levels defined in that breakaway are represented by eight hexadecimal characters on the key. For 
help with reading the levels from the hexadecimal characters see Table 7.12.

To assign a breakaway step key

1. Open the RCP-NKQ editor (see “Opening the RCP-NKQ Editor” on page 4–1).

2. On the simulated RCP-NKQ, select the key that you want to use for the breakaway step.

3. In the pop-up dialog:

a. Select Function as the key type.

b. From the Function Key value field, select Breakaway Step.

The simulated RCP-NKQ in DashBoard shows BRK STEP on the selected key.

4. Send the current document to the device by clicking Send Configuration located on the lower Device 
Configuration window (see “Sending a Document to a Device” on page 4–24).

When this configuration is sent to an RCP-NKQ, the key shows the name of the currently selected breakaway 
with the breakaway step indicator.

Assigning a Macro to a Key

If you want to perform several tasks at the press of a key, assign a macro key to the RCP-NKQ, then record a macro 
using this key. For more information see “Recording a Macro Using the Panel” on page 4–14. You can assign up 
to 40 macros to an RCP-NKQ.

To assign a macro to a key

1. Open the RCP-NKQ editor (see “Opening the RCP-NKQ Editor” on page 4–1).

2. On the simulated RCP-NKQ, select the key that you want to use for the macro.

3. In the pop-up dialog:
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a. Select Macro as key type.

b. In the Macro value field, enter the unique number that you want to use to identify the macro, then press 
Enter.

The simulated RCP-NKQ in DashBoard shows the macro number on the selected key, for example, Macro 1.

4. Send the current document to the device by clicking Send Configuration located on the lower Device 
Configuration window (see “Sending a Document to a Device” on page 4–24).

Recording a Macro Using the Panel

Macros can be recorded using the keys on the RCP-NKQ. You may record up to 112 key presses in a macro. A 
macro key must be assigned on the RCP-NKQ before you can use it to record the macro.

To record a macro using the panel

1. On the RCP-NKQ, hold the Macro <n> key until the key shows Macro Rec.

2. Release the key.

The key flashes Macro Rec slowly, indicating that the RCP-NKQ is now ready to record a macro.

3. Press the required keys in the correct sequence until your task is completed.

Each key acknowledges that it has been pressed by flashing briefly.

4. Press the Macro <n> key again to end the recording process.

The macro is recorded.

 If you unassign the Macro <n> key from the macro function, the recorded macro is held in memory. You can 
re-assign the macro to a key using the same macro number under which the macro was recorded.

Adding to a Macro Using the Panel

You can add extra key sequences to an existing macro. You can join two existing macros together.

To add to a macro using the panel

1. On the RCP-NKQ, hold the Macro <n> key until the key shows Macro Rec, then release the key.

The key flashes Macro Rec slowly, indicating that the RCP-NKQ is now ready to record a macro.

2. Hold the Macro <n> key again.

The selected macro is played back internally, ready to receive the additional key sequences.

3. Do one of the following:

• To add an extra key sequence, press the required keys in the correct sequence until your task is completed.

• To add an existing macro, press the key for that macro.

Each key acknowledges that it has been pressed by flashing briefly.

4. Press the Macro <n> key again to end the recording process.

The existing macro is overwritten with the new macro.

Configuring a Macro

Macros can be configured in DashBoard using the Macros Events tab.

To configure a macro using

1. Assign a macro to a key (see “Assigning a Macro to a Key” on page 4–13).

2. In DashBoard, select the Macro Events tab.

3. In the Num. Rows. box of the macro, enter or select the number of events to be assigned.
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4. Click Update to add the events to the Event column of the macro.

5. In the Function column, use the list to select the function to perform for the event. The options are as follows:

• Switch — performs a standard crosspoint switch.

• Macro — performs a macro within the executed macro.

• Protect — creates a protect condition on the destination of the selected crosspoint (see “Assigning a 
Protect Key” on page 4–16).

6. In the Output column, perform the following:

a. Double-click the Output box.

b. Enter a destination for the event.

c. Press Enter.

7. In the Input column, perform the following:

a. Double-click the Input box.

b. Enter a source for the event.

c. Press Enter.

8. In the Level Mask column, select the level mask or masks for the device affected by the macro.

Each function can occur on any available level, independent of any other function within the same macro 
event.

9. Repeat Steps 5 to 8 for any remaining events of the macro. 

10. Send the current document to the device by clicking Send Configuration located on the lower Device 
Configuration window (see “Sending a Document to a Device” on page 4–24).

Assigning a Name to a Macro

Macros can be assigned custom names in DashBoard using the Macro Names tab.

To assign a name to a macro

1. In DashBoard, select the Macro Names tab.

2. In the Name column, perform the following:

a. Double-click the Name box of the macro.

b. Enter a name.

c. Press Enter.

Configuring a Macro Using a Web Browser

Macros can be configured by using a web browser.

To configure a macro using a web browser

1. Assign a macro to a key (see “Assigning a Macro to a Key” on page 4–13).

2. In the Device Properties page, click Macro Events.

3. In the Num Rows for Macro box of the macro, enter the number of events to be assigned.

4. Press Enter.

The Device Properties page displays a message that the settings were sent to the device.

5. Click the Online tab.

The Online Devices page opens.
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6. Click the Properties button for the RCP-NKQ.

The Device Properties page opens.

7. In the Device Properties page, click Macro Events.

The Device Properties page displays the Macro # tables.

8. In the Function column, use the list to select the function to perform for the event. The options are as follows:

• Switch — performs a standard crosspoint switch.

• Macro — performs a macro within the executed macro.

• Protect — creates a protect condition on the destination of the selected crosspoint.

9. In the Output column, enter a destination for the event.

10. In the Input column, enter a source for the event.

11. In the Level Mask column, select the level mask or masks for the device affected by the macro.

Each function can occur on any available level, independent of any other function within the same macro 
event.

12. Repeat Steps 8 to 11 for any remaining events of the macro.

13. Click Submit Settings to send the current document to the device.

The Device Properties page displays a message that the settings were sent to the device.

Assigning a Name to a Macro Using a Web Browser

Macros can be assigned custom names using a web browser.

To assign a name to a macro using a web browser

1. Open the Device Properties page in a web browser.

2. In the Device Properties page, click Macro Names.

3. In the Name column of the Macro Names table, perform the following:

a. Click the Name box of the macro.

b. Enter a name.

c. Press Enter.

The Device Properties page displays a message that the settings were sent to the device.

Assigning a Protect Key

To prevent switching of critical crosspoints by others, assign a protect key for use on the RCP-NKQ. The protect 
function ensures that the selected destination can only receive the selected source across the selected levels. Once 
protected, the selected levels on a destination cannot be switched by other remote control panels (or by the same 
remote control panel if Block All Panels is selected). The source is not protected, and can be freely routed to other 
destinations if required. You can protect any number of destinations. For more information see “Protecting a 
Destination” on page 5–4.

 You can also use the protect key to lock the RCP-NKQ against all key presses (see “Locking the RCP-NKQ” on 
page 5–4).

Assigning a Protect Key

Protect keys can be assigned using the editor in DashBoard.
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To assign a protect key

1. Open the RCP-NKQ editor (see “Opening the RCP-NKQ Editor” on page 4–1).

2. On the simulated RCP-NKQ, select the key that you want to use for the protect key.

3. In the pop-up dialog:

a. Select Function as the key type.

b. Select Protect from the value field.

The simulated RCP-NKQ in DashBoard shows PROT Loc on the selected key.

4. Select the Configuration tab.

5. Scroll to the Configuration frame.

6. Select the mode of protection that you want for the protect key. Use the information in Table 4.6 as a guide.

7. Send the current document to the device by clicking Send Configuration located on the lower Device 
Configuration window (see “Sending a Document to a Device” on page 4–24).

Assigning a Take Key

If you want to pre-load a switch sequence, but delay the switch, assign a TAKE key on the menu. If a TAKE key is 
assigned, then all switches on that menu are activated by pressing the TAKE key instead of the 
source/crosspoint/macro key. You should assign a TAKE key on each menu that requires this switching type.

To assign a take to a key

1. Open the RCP-NKQ editor (see “Opening the RCP-NKQ Editor” on page 4–1).

2. On the simulated RCP-NKQ, select the key that you want to use for the TAKE key.

3. In the pop-up dialog:

a. Select Function Key as the key type.

b. Select Take as the key value.

The simulated RCP-NKQ in DashBoard shows TAKE on the selected key.

4. Send the current document to the device by clicking Send Configuration located on the lower Device 
Configuration window (see “Sending a Document to a Device” on page 4–24).

Assigning a Chop Key

If you want to toggle two different sources to the same destination, assign a CHOP key to the RCP-NKQ. For 
example, the destination may be the monitor that you are viewing, and the sources may be feeds from two different 
camera locations. When you use the CHOP key, the toggle rate can be slow or fast (see “Toggling Between Two 
Sources” on page 5–5).

Table 4.6  Protect Modes

Protect Mode Description

Block Other 
Panels

The protected destination and level(s) cannot be switched to another source 
by other remote control panels.

The protected destination and level(s) can be switched to another source on 
the current remote control panel.

Block All Panels The protected destination and level(s) cannot be switched to another source 
by the current remote control panel or other remote control panels.
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To assign a chop to a key

1. Open the RCP-NKQ editor (see “Opening the RCP-NKQ Editor” on page 4–1).

2. On the simulated RCP-NKQ, select the key that you want to use for the CHOP key.

3. In the pop-up dialog:

a. Select Function Key as the key type.

b. Select Chop as the key value.

The simulated RCP-NKQ in DashBoard shows CHOP on the selected key.

4. Send the current document to the device by clicking Send Configuration located on the lower Device 
Configuration window (see “Sending a Document to a Device” on page 4–24).

Assigning a Panel Lock Key

It may be necessary at times to lock the entire RCP-NKQ from changes. If this function is required, assign a panel 
lock key. You can also lock the RCP-NKQ using the Panel Locked check box on the Configuration tab (see 
“Locking the RCP-NKQ” on page 4–20).

To assign a panel lock key

1. Open the RCP-NKQ editor (see “Opening the RCP-NKQ Editor” on page 4–1).

2. On the simulated RCP-NKQ, select the key that you want to use for the panel lock.

3. In the pop-up dialog:

a. Select Function Key as the key type.

b. Select Panel Lock as the key value.

The simulated RCP-NKQ in DashBoard shows LOCK ON on the selected key.

4. Send the current document to the device by clicking Send Configuration located on the lower Device 
Configuration window (see “Sending a Document to a Device” on page 4–24).

Assigning a Menu Link to a Key

You can assign a pre-defined menu to a key on the RCP-NKQ. For information on how to set up a menu see 
“Setting Up Menus” on page 4–7.

To assign a menu link to a key

1. Open the RCP-NKQ editor (see “Opening the RCP-NKQ Editor” on page 4–1).

2. On the simulated RCP-NKQ, select the key that you want to use for the menu.

3. In the pop-up dialog:

a. Select Menu Link as the key type.

b. Select the name of the menu that you want to use.

The simulated RCP-NKQ in DashBoard shows the menu on the selected key, for example, CAM.

4. Click the down arrow in the Menu field below the simulated RCP-NKQ, then select the menu that you have 
just assigned.

5. Assign functions to the keys in this menu (see “Assigning Functions to Keys on the RCP-NKQ” on page 4–
9).

For example, if this menu is for the purpose of selecting a destination, assign the keys as destinations. You may 
choose to have this destination menu fall back to a source menu.

6. Send the current document to the device by clicking Send Configuration located on the lower Device 
Configuration window (see “Sending a Document to a Device” on page 4–24).
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Assigning Menu Navigation to a Key

If you have multiple menus assigned in the RCP-NKQ, you may want to include some navigation keys to enhance 
movement through the menus.

To assign menu navigation to a key

1. Open the RCP-NKQ editor (see “Opening the RCP-NKQ Editor” on page 4–1).

2. On the simulated RCP-NKQ, select the key that you want to use for navigation.

3. In the pop-up dialog:

a. Select Menu Navigate as the key type.

b. Select the option that you want from the key value. Use the information in Table 4.7 as a guide.

The simulated RCP-NKQ in DashBoard shows the type of navigation on the selected key, for example, UP 
MENU.

4. Send the current document to the device by clicking Send Configuration located on the lower Device 
Configuration window (see “Sending a Document to a Device” on page 4–24).

When this configuration is sent to an RCP-NKQ, the key shows an arrow in the top line indicating the direction 

of the menu (for example,  for up) with the first five characters for the menu shown below. If the crosspoint 
layer is selected, the key shows the current layer and the crosspoint layer indicator.

Assigning a Menu Display to a Key

If you want to be able to view the status of the currently selected input, output or breakaway, assign the menu 
display function to a key. This key shows the name of the currently selected input, output or breakaway.

To assign a menu display to a key

1. Open the RCP-NKQ editor (see “Opening the RCP-NKQ Editor” on page 4–1).

2. Select the key that you want to use for displaying the status.

3. In the pop-up dialog:

a. Select Menu Display as the key type.

b. Select the option that you want from the key value. Use the information in Table 4.8 as a guide.

Table 4.7  Menu Navigation Descriptions

Option Function

Home Returns to the menu defined in Menu Number 1 on the Menu Details tab, 
Menu Details frame.

Next Menu Goes to the next menu, if one is held in the buffer.

Previous Menu Goes to the previously used menu, if one is held in the buffer.

Up Menu Goes up a menu, as defined on the Menu Details tab, Menu Details frame.

Down Menu Goes down a menu, as defined on the Menu Details tab, Menu Details frame.

XPoint Layer Shows the breakaway, destination or source for any visible crosspoint keys. You 
can step through the layers of a crosspoint by pressing the crosspoint layer key.
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The simulated RCP-NKQ in DashBoard shows the type of display on the selected key, for example, DISP 
INPUT.

4. Send the current document to the device by clicking Send Configuration located on the lower Device 
Configuration window (see “Sending a Document to a Device” on page 4–24).

When this configuration is sent to an RCP-NKQ, the key shows the label for the current source, destination or 
breakaway (if the breakaway step key is used to cycle through the breakaways), for example Server 1, Server 2 
or SDI.

Unassigning a Key

If a key is not used for any function it should be unassigned.

To unassign a key from any function

1. Open the RCP-NKQ editor (see “Opening the RCP-NKQ Editor” on page 4–1).

2. On the simulated RCP-NKQ, select the key that you want to unassign from a function.

3. In the pop-up dialog, select Clear Key as key type.

The simulated RCP-NKQ in DashBoard shows UN-ASIGN on the selected key. If the display option for an 
unassigned key is set to Off, the key is black.

4. Send the current document to the device by clicking Send Configuration located on the lower Device 
Configuration window (see “Sending a Document to a Device” on page 4–24).

Locking the RCP-NKQ

You can use the DashBoard to lock a remote control panel against accidental changes. The remote control panel can 
only be unlocked locally if you have assigned a LOCK On or protect key. If these keys have not been assigned, 
then the remote control panel may only be unlocked via DashBoard.

To lock the RCP-NKQ

1. Open the RCP-NKQ editor (see “Opening the RCP-NKQ Editor” on page 4–1).

2. Select the Configuration tab.

3. Scroll to the Configuration frame.

4. Select the Panel Locked check box.

Table 4.8  Display Layer Options

Option Function

Current Output Shows the currently selected output on the face of the key.

Current Input Shows the currently selected input on the face of the key.

Current Levels Shows the currently selected breakaway on the face of the key. If a level 
key is selected on the RCP-NKQ, the level mask is shown as eight 
hexadecimal characters on the face of the display layer key. For help 
with reading the levels from the hexadecimal expression see “Viewing 
the Breakaways Assigned to an RCP-NKQ” on page 5–2.
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5. Send the current document to the device by clicking Send Configuration located on the lower Device 
Configuration window (see “Sending a Document to a Device” on page 4–24).

The remote control panel is locked.

• If a Panel Lock key is assigned, this may be pressed to unlock the remote control panel.

• If a protect key is assigned, this may be held down for 3 seconds to lock/unlock a panel.

• If neither of these keys are assigned, the remote control panel can only be unlocked by clearing the Panel 
Locked check box, then sending this document to the device.

Setting Up Machine Control

If your routing switcher system uses a machine control routing switcher to provide reciprocal switching of RS-422 
signals, your RCP-NKQ must be set up to handle these switches. Machine control must be enabled in the 
RCP-NKQ, and the router level used for machine control must match that set in the machine control routing 
switcher.

To set up machine control

1. Open the RCP-NKQ editor (see “Opening the RCP-NKQ Editor” on page 4–1).

2. Select the Configuration tab.

3. Scroll to the Configuration frame.

4. Select the Machine Control Enabled check box.

5. Use the up and down arrows in the Machine Control Level field to adjust the machine control level to match 
the level that the machine control routing switcher has been assigned.

6. Send the current document to the device by clicking Send Configuration located on the lower Device 
Configuration window (see “Sending a Document to a Device” on page 4–24).

Assigning a Machine Control Key

If your master device controls multiple slave devices, you need a machine control key to temporarily disable 
reciprocal switching until the last slave device is routed.

To assign a machine control key

1. Open the RCP-NKQ editor (see “Opening the RCP-NKQ Editor” on page 4–1).

2. On the simulated RCP-NKQ, select the key that you want to use for machine control.

3. In the pop-up dialog:

a. Select Function Key as the key type.

b. Select MC Key as the key value.

The simulated RCP-NKQ in DashBoard shows MC KEY on the selected key.

4. Send the current document to the device by clicking Send Configuration located on the lower Device 
Configuration window (see “Sending a Document to a Device” on page 4–24).

Assigning a De-assign Key

To assign a de-assign key

1. Open the RCP-NKQ editor (see “Opening the RCP-NKQ Editor” on page 4–1).

2. On the simulated RCP-NKQ, select the key that you want to use to de-assign a machine control port.

3. In the pop-up dialog:
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a. Select Function Key as the key type.

b. Select Deassign.

The simulated RCP-NKQ in DashBoard shows DE-ASIGN on the selected key.

4. Send the current document to the device by clicking Send Configuration located on the lower Device 
Configuration window (see “Sending a Document to a Device” on page 4–24).

Setting Up Virtual Routing and Resource Management

The routing systems described in this section use physical switching only. That is, source 1 on level 1 refers to the 
first socket on the back of a routing switcher assigned to level 1. When an NK-VRC Virtual Routing Core is added 
to the system, virtual routing is possible. With virtual routing, physical inputs and outputs are mapped to virtual 
sources and destinations. For example, a virtual source may switch input 15 on level 1 and input 27 on level 2. 

The RCP-NKQ must have virtual routing enabled to use this feature. When virtual routing is enabled, the sources 
and destinations that you assign on the RCP-NKQ refer to the virtual sources and destinations, as defined in the 
NK-VRC.

When the RCP-NKQ is used with an Ultrix router, ensure that Virtual Routing is enabled and the Comms Retry 
Delay Factor set to 80ms or greater on the panel.

Additionally, resource management may be implemented on the NK-VRC to manage routing of different signal 
types between one or more routers using external resources.

For More Information on...

• setting up and using an NK-VRC, refer to the NK-VRC Virtual Routing Core User Guide.

To set up virtual routing and resource management

1. Open the RCP-NKQ editor (see “Opening the RCP-NKQ Editor” on page 4–1).

2. Select the Configuration tab.

3. Scroll to the Configuration frame.

4. Perform one of the following:

• If you want to enable virtual routing, select the Virtual Routing Enabled check box.

• If you want to disable virtual routing, clear the Virtual Routing Enabled check box.

5. Send the current document to the device by clicking Send Configuration located on the lower Device 
Configuration window (see “Sending a Document to a Device” on page 4–24).

To assign a DE-ASSIGN key

Refer to the section “Assigning a De-assign Key” on page 4-21.

Setting the Retry Time for a Switch Failure

When you make a switch, a switch request is sent from the RCP-NKQ to the routing switcher. If the RCP-NKQ 
does not receive a response from the routing switcher, the RCP-NKQ retries the request after the time specified in 
the Comms Retry Delay Factor field.

Systems require different retry times, depending on the transfer of requests and responses between modules.
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To set the retry time

1. Open the RCP-NKQ editor (see “Opening the RCP-NKQ Editor” on page 4–1).

2. Select the Configuration tab.

3. Scroll to the Configuration frame.

4. Use the up and down arrows in the Comms Retry Delay Factor field to adjust the retry time according to the 
requirements of your routing switcher system (see Table 4.9).

5. Send the current document to the device by clicking Send Configuration located on the lower Device 
Configuration window (see “Sending a Document to a Device” on page 4–24).

Returning to the Home Menu

You can use the DashBoard to return to the Home menu if the RCP-NKQ is not responding to key presses.

To return to the Home menu

1. Open the RCP-NKQ editor for the remote control panel that is not responding (see “Opening the RCP-NKQ 
Editor” on page 4–1).

2. Select the Configuration tab.

3. Scroll to the Configuration frame.

4. Select the Return to Home Menu check box.

5. Send the current document to the device by clicking Send Configuration located on the lower Device 
Configuration window (see “Sending a Document to a Device” on page 4–24).

The RCP-NKQ returns to the Home menu.

Loading the Factory Defaults

If you need to return the RCP-NKQ to a known configuration, you can use DashBoard to load the factory defaults.

To load the factory defaults

1. Open the RCP-NKQ editor for the remote control panel that needs factory defaults loaded (see “Opening the 
RCP-NKQ Editor” on page 4–1).

2. Select the Configuration tab.

3. Scroll to the bottom of the Configuration tab.

4. Select the Load Factory Defaults check box.

5. Send the current document to the device by clicking Send Configuration located on the lower Device 
Configuration window (see “Sending a Document to a Device” on page 4–24).

The factory defaults are loaded.

Table 4.9  Retry Time

System Retry Time
(ms)

Direct T-Bus RCP to router communications 10

Using NK-VRC in the system 20

Communications via IP networks 80

NK Series Hub 250
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Saving the Current Document for the RCP-NKQ

The parameters that you have set up on the device tab for an RCP-NKQ are stored in a configuration document. 
When you have finished making changes to the configuration of the RCP-NKQ, you should save the document, 
then add the location of this document to the File Explorer pane so that you can open it later.

Saving a Device Document

To save a device document

1. Select the device tab containing the document that you want to save.

2. In DashBoard, right-click the device in the Device Tree.

3. Click Save As....

4. Navigate to the folder in which you want to save the configuration document.

5. Click Save.

Adding a Directory to File Explorer

To add the document location to the File Explorer pane

1. Right-click on  in the File Explorer pane.

2. Click Add Directory... 

3. Navigate to the folder in which you saved the configuration document.

4. Click Add.

The folder and any saved documents may now be accessed via the File Explorer pane.

Opening a Saved Document

To open a saved document

1. In the File Explorer pane, navigate to the saved configuration document that you want to open.

2. Double-click on the icon for the document.

Sending a Document to a Device

When you have made changes to the configuration of a device, the changes are not activated in the device until the 
document containing the changes is sent to the device. You can open a saved configuration document, make 
changes to it, save it, then send it to a device.

To send the current document to a device

1. Click Send Configuration (located on the lower pane of the Device Configuration window).

The Send Config to NK Device dialog automatically selects configuration pages with changed values for 
sending. You may select all tables by checking the Select Pages if desired. 

The Send Config to NK Device dialog also lists similar devices within your routing system network. Smart 
Paste is automatically selected for devices that are of a similar type but not directly related to the current 
configuration document. This ensures only compatible data will be sent to other devices.
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2. Select the pages that you want to send to the device. Use the information in Table 4.10 as a guide.

3. Select the device to which you want to send the current document from the Select Devices list.

4. Click OK.

Table 4.10  Page Descriptions

Page Description

Home The information contained in the Device Details frame and the 
Configuration tab.

Key Definitions The information defining how keys have been assigned.

Menu Details The information contained on the Menu Details tab.

Labels The information contained in the combined pool of input and output labels.

Input Assign The information contained on the Input Assigns tab.

Output Assign The information contained on the Output Assigns tab.

Macro Names The information contained on the Macro Names tab.

Macro Events The information contained on the Macro Events tab.
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Operating the RCP-NKQ

LCD Keys

The LCD keys reflect any one of the following, depending on their current use:

• current status

• label

• current display mode

• special indicators

The text on the key changes as required. The color and inverse settings change depending upon the status of the key 
and how these display options have been set up. The default status shows when the key is not selected. The selected 
status shows when the key is selected (see “Setting Up Display Options for Each Type of Key on the 
RCP-NKQ” on page 4–9).

Figure 5.7  Special indicators for the LCD keys

Breakaways and Levels

Breakaways are made up of one or more levels that are defined as a level mask, then assigned to a key (see “Setting 
Up Breakaways” on page 4–6). You can assign multiple breakaway keys to an RCP-NKQ. You can select only one 
breakaway for a switch.

One level may be assigned to a key. You can assign multiple level keys to an RCP-NKQ. You can select multiple 
level keys prior to a switch.

Selecting Breakaways and Levels

To select a breakaway or level

• Press the corresponding key.

Breakaway warning indicator (breakaway and source keys)

Breakaway step indicator (breakaway step key)

Crosspoint indicator (crosspoint key)

Crosspoint layer indicator (crosspoint layer key)

Protection indicator (destination and protect key)

Navigation indicator (menu navigation keys)
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The key shows the color and inverse status for a selected breakaway or level. If you have selected a custom 
breakaway, and separate level keys are assigned to the RCP-NKQ, the level keys corresponding to the levels in 
the breakaway also show the color and inverse status for a selected key.

When a breakaway is selected, the status of the routing switcher shown on the key is the status of the lowest 
router level in the breakaway.

If a breakaway warning is indicated on the key, it shows the routing switcher status in the current breakaway 
when compared to the router levels defined in the breakaway in the configuration.

Notes

Keep the following in mind when selecting breakaways and levels:

• You cannot add a level to a custom breakaway by pressing a level key.

• A breakaway warning is caused by:

› no response from the routing switcher system on one or more router levels

› a difference in status of any level in the currently selected breakaway when compared with the first level in the 
breakaway

To de-select a breakaway

• Select another custom breakaway, the default breakaway, or a level key.

To de-select a level

• Press the level key again.

Viewing the Breakaways Assigned to an RCP-NKQ

You can view the breakaways assigned to an RCP-NKQ if a breakaway step key is assigned to the RCP-NKQ. The 
breakaway step key cycles to the next breakaway in the list each time it is pressed, and shows the name of the 
currently selected breakaway, with the breakaway step indicator in the bottom right of the key (see Figure 5.7). As 
each breakaway is selected, the level(s) defined in that breakaway are illuminated, if corresponding level keys have 
been assigned to the RCP-NKQ.

To view the breakaways assigned to an RCP-NKQ

• Press the breakaway step key repeatedly to cycle through the available breakaways.

The breakaway step key shows the selected status as you step through the breakaways. When the default 
breakaway is selected, the breakaway step key changes to the default status.

Notes

Keep the following in mind:

• If a breakaway warning exists, it is indicated at the bottom right of the breakaway key and the source key (see 
Figure 5.7).

• If a breakaway warning is current for the selected breakaway, the breakaway warning indicator is shown on the 
screen.

To view the name and levels of a breakaway

• Hold the breakaway key.

The name of the breakaway and an 8-character expression appears on the key. Each character provides a 
hexadecimal representation of the use of four levels, from 32 to 29 on the left, through to 4 to 1 on the right. 
Table 7.12 provides a look-up table for reading the levels from the hexadecimal characters.

To view the levels defined in a breakaway

1. Select the breakaway.

2. Hold the breakaway step key.
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An 8-character expression appears on the key. Each character provides a hexadecimal representation of the use 
of four levels, from 32 to 29 on the left, through to 4 to 1 on the right. Table 7.12 provides a look-up table for 
reading the levels from the hexadecimal characters.

 If level keys have been assigned to the RCP-NKQ, these show the selected status. The level keys show the 
default status when the default breakaway is selected.

Making a Switch

A switch can be made with or without a TAKE key assigned to the menu. If there is no TAKE key assigned, a 
switch is made when the source/crosspoint/macro key is pressed. If a TAKE key is assigned to the menu, the switch 
is made when the TAKE key is pressed.

Switching with a Breakaway, Destination, and Source

To make a switch

1. Press the key(s) for the level(s) or breakaway that you want to use.

If you do not select a custom breakaway or level key, the default breakaway is used.

To de-select a level, press the key again.

2. Press the destination key that you want to use.

3. Press the source key that you want to use.

4. If a TAKE key is assigned to the menu, press TAKE.

5. If you want to protect the destination, press PROT Off, if it has been assigned (see “Protecting a Destination” 
on page 5–4).

Notes

Keep the following in mind:

• If you have selected the Breakaway Reset check box in the configuration document for the RCP-NKQ, the 
breakaway returns to the default breakaway after the switch is made.

• If resource management is used, the following may occur:

If the requested switch includes a resource, the button will display a resource indicator as shown in (Figure 5.8).

Figure 5.8  Resource indicator for the LCD Source key

After pressing source key to initiate switch:

› if no rule can be found to connect two classes, it displays NO RULE message

› if no resource exists for the selected rule, it displays NO RSRCE message

› if resource exists but panel priority does not have access rights, it displays NO ACCES message

Switching with a Crosspoint

To make a switch using a pre-defined crosspoint key

1. Press the crosspoint key.

2. If a TAKE key is assigned to the menu, press TAKE.

3. If you want to protect the switch, press PROT Off, if it has been assigned (see “Protecting a Destination” on 
page 5–4).

Resource indicator (Source key)
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Notes

Keep the following in mind:

• When you make a crosspoint switch, the corresponding breakaway, destination and source keys illuminate.

• If you have selected the Breakaway Reset check box in the configuration document for the RCP-NKQ, the 
breakaway returns to the default breakaway after the switch is made.

Using a Macro

To use a macro

1. Press the macro key.

2. If a TAKE key is assigned to the menu, press TAKE.

Locking the RCP-NKQ

You can lock the RCP-NKQ if a panel lock or protect key has been assigned to the RCP-NKQ.

The protect key must be held to lock the RCP-NKQ.

To lock the RCP-NKQ using a panel lock key

1. Press LOCK Off.

The panel lock key flashes red three times before returning to the default status. The label changes to 
LOCK On.

Every key on the RCP-NKQ becomes inactive, except for the LOCK On key.

2. If you want to unlock the RCP-NKQ, press LOCK On.

The text on the panel lock key changes to LOCK Off.

To lock the RCP-NKQ using a protect key

1. Hold PROT Off for 3 seconds.

Every key on the RCP-NKQ becomes inactive, except for the PROT Off key, and LOCK On key, if assigned.

2. If you want to unlock the RCP-NKQ, hold PROT Off, or press the panel lock key, if assigned.

 If a panel lock key is assigned to the RCP-NKQ, this key changes to LOCK On, and the PROT Off key remains 
the same.

Protecting a Destination

You can use a protect key to prevent switching of critical crosspoints by others. The protect function ensures that 
the selected destination can only receive the selected source across the selected levels. Once protected, the selected 
levels on a destination cannot be switched by other remote control panels (or by the same remote control panel if 
Block All Panels is selected). The source is not protected, and can be freely routed to other destinations if required. 
You can protect any number of destinations.

You can set the extent of protection that is used, that is, protected against other remote control panels or protected 
against all remote control panels, via the DashBoard (see “Assigning a Protect Key” on page 4–16).

To protect a destination

1. Make the switch.

2. Press PROT Off.

The status of the protect key changes to PROT Loc, and the protection indicator is shown at the bottom right of 
both the protect key and the destination key.



RCP-NKQ User Guide (v3.0) Operating the RCP-NKQ • 5–5

 If you are protecting a destination on a level for which a routing switcher does not respond, a protect breakaway 
error (BwayErr) occurs.

To remove the protection from a destination:

1. Press the key for the protected destination.

2. Press PROT Loc.

The status of the key changes to PROT Off and the protection indicator is removed from the destination key.

Clearing Protects Held by an RCP-NKQ

A protect that is held by an RCP-NKQ prevents the crosspoint being changed by another user. A protect can be sent 
to the routing switcher from any connected remote control panel. Protects can be applied at any time, and are 
indicated by the protection indicator at the bottom right of the destination key.

To clear one protect from an RCP-NKQ

1. Press the destination key that has the protection applied.

The protection indicator is shown at the bottom right of the destination key.

2. Press PROT Loc.

To clear all of the protects from an RCP-NKQ

1. Open the RCP-NKQ editor for the remote control panel that you want to clear (see “Opening the RCP-NKQ 
Editor” on page 4–1).

2. Select the Configuration tab.

3. Scroll to the Configuration frame.

4. If you want to clear all protects held by the RCP-NKQ, select the Clear Protect(s) check box.

5. Send the current document (see “Sending a Document to a Device” on page 4–24).

 Protects may be held by other remote control panels. Each remote control panel attached to a routing switcher 
has to have its protects cleared separately.

Toggling Between Two Sources

If a CHOP key has been assigned to the RCP-NKQ, you can use this key to toggle between two sources.

To toggle between two sources

1. Press the key for the destination on which you want to receive the sources.

2. Press the key for the first source that you want to receive, followed by the TAKE key, if assigned.

3. Press the key for the second source that you want to receive, followed by the TAKE key, if assigned.

4. Do one of the following:

• Press CHOP once to toggle slowly between the two sources (toggle cadence is 1700 ms). The status of the 
key changes to CHOP Slow and the two source keys illuminate alternately.

• Press CHOP twice to toggle rapidly between the two sources (toggle cadence is 400 ms). The status of the 
key changes to CHOP Fast and the two sources keys illuminate alternately.
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5. Do one of the following:

• If you are in slow chop, press the chop key twice to stop toggling between the two sources.

• If you are in fast chop, press the chop key once to stop toggling between the two sources.

The status of the key returns to CHOP.

Using a Menu

A key that has a menu assigned has the name of the menu on the key.

To use a menu

1. Press the key that has the menu assigned to it.

2. Press the key that you want to use in that menu.

If the menu has been set up to fall back to another menu, the RCP-NKQ goes to the pre-defined menu (see 
“Setting Up Menus” on page 4–7).

 If you need to return to the Home menu, but the RCP-NKQ is not responding, use the DashBoard to do this. For 
more information see “Returning to the Home Menu” on page 4–23.

De-Assigning a Machine Control Port

If you want to stop machine control on a particular port temporarily, you can park the port by de-assigning it.

To de-assign a machine control port

1. Press the key for the machine control port that you want to park.

2. Press DE-ASIGN.

To unpark the machine control port

• Make a machine control switch.

De-Assigning Resources

De-assigning resources can be done in two ways:

• Route a different source to that destination that does not require a resource. The assigned resource will 
automatically be de-assigned.

• Use the de-assign button.

To de-assign a resource

1. Select the destination to which the resource is attached.

2. Press DE-ASIGN.

If the selected destination does not include a resource, one of two things will occur:

• If the panel is in MC mode, park the current destination (switch same source number to destination).

• If the panel is not in MC mode, it displays the MC MODE? message.

 The ability of a panel to de-assign a resource using the DE-ASIGN button will depend on the priority assigned to 
the panel and the resource in the NK-VRC virtual routing core.

Operating Linked Remote Control Panels

You can link RCP-NKQs together, or link them with RCP-NKQs. The remote control panels must have panel link 
addresses set, as described  “Linking Remote Control Panels” on page 4–4. Once these addresses are set correctly, 
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the remote control panels transfer status, request and response information between them. Effectively, the remote 
control panels combine to form one big remote control panel. Up to 255 remote control panels may be linked 
together.

If you want to operate a 34-key remote control panel with the inputs and outputs of a 32 × 32 routing switcher, you 
may link two RCP-NKQs together. Another use may be to define all the crosspoints that you need without using 
menus and pages. To do this, you need as many keys as there are crosspoints.

 The input and output assign labels should be identical across all remote control panels.

Function Keys

Once remote control panels are linked, they operate in a similar manner as the unlinked state. If a special function 
key (CHOP, DE-ASIGN, or a panel lock, protect, breakaway, breakaway step or machine control) is assigned to 
one remote control panel, it is effective across all linked remote control panels, regardless of the location of other 
relevant keys.

Notes

Keep the following in mind:

• A TAKE key does not operate across menus within the same remote control panel however, it does operate 
across linked remote control panels as long as it is on a current menu at the time that the source/crosspoint/macro 
key is pressed.

• If a TAKE key is assigned, the selected source/crosspoint/macro key and the TAKE key flash to indicate that the 
remote control panel is waiting for TAKE to be pressed.

Destinations and Sources

Destinations and sources from different remote control panels may be switched.

Crosspoints

Crosspoints can only be programmed to a remote control panel via the DashBoard, so these are specific to the 
remote control panel.

Switching

When a breakaway, destination and source are sent in a switch request from a remote control panel, each linked 
remote control panel receives the level mask, destination and source information via a linked panel message, and 
either reflects the status, or behaves accordingly (for example, locking the remote control panel or entering macro 
record mode).

Breakaways

Breakaway numbers are not sent in the switch request, thus removing the need for identical breakaway definitions 
across linked remote control panels. As such, breakaway step is not available across linked remote control panels. 
You can view the breakaways within the same remote control panel, in line with unlinked behaviour.

Menus

Menus and menu navigation keys are only effective on the remote control panel to which they are assigned.

Macros

Macros may be recorded or added to across linked remote control panels.
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Resetting Devices

If you want to return to a known operating state and configuration, you can:

• send the default document to the RCP-NKQ (see “Sending a Document to a Device” on page 4–24)

• reset the device

• reload the factory defaults

If the RCP-NKQ fails to accept any documents that are sent to it, then you should reset the device. When you 
perform a reset, the RCP-NKQ takes on the last-known operating state and configuration that is stored in memory. 
If the RCP-NKQ fails to reset, then reload the factory defaults via a web browser.

To reset a device

• In the IPS Explorer pane, right-click on the RCP-NKQ that you want to reset, then select Reset Device.

Viewing Status and Alarms

An indication that alarms are present for a device is visible in the IPS Explorer pane. If a device has one or more 
alarms, a small circle appears in the icon for the device.

Figure 5.9  IPS Explorer pane showing device with status/alarm indication

To view the status and any alarms for an RCP-NKQ

1. Open the RCP-NKQ editor (see “Opening the RCP-NKQ Editor” on page 4–1).

2. Select the Configuration tab.

3. Scroll to the Alarms frame.

The status of the RCP-NKQ is shown via a number of colored buttons and labels.

status/alarm indication
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Troubleshooting

Table 6.11  Troubleshooting

Problem Cause Action

I am stuck on a menu 
with no way back.

A return loop was not set up 
when the menu was defined.

Return to the Home menu as outlined in “Returning to the 
Home Menu” on page 4–23).

RCP-NKQ is not 
responding to 
DashBoard.

Information stored in the 
RCP-NKQ has been 
corrupted.

Try the following until the RCP-NKQ responds:

• Power cycle the RCP-NKQ

• Check the T-Bus communications connections

• Send the default document to the RCP-NKQ

The RCP-NKQ is not 
switching correctly.

The NK Series devices are 
not set up correctly to 
operate with or without 
virtual routing.

Set up the devices with virtual routing enabled or disabled, 
as required (see “Setting Up Virtual Routing and 
Resource Management” on page 4–22).

The RCP-NKQ takes a 
long time for switch 
response to be 
displayed

The current breakaway is 
trying to switch a level when 
there is no router configured 
for that level.

Ensure the current breakaway only includes levels matching 
connected routers

The display briefly 
indicates NO RESP

The RCP-NKQ times out 
while waiting for response 
from router(s)

Increase the Comms Retry Delay value. Refer to “Setting 
the Retry Time for a Switch Failure” on page 4–22.
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Hexadecimal to Router Level 
Conversion
The router level is represented by eight hexadecimal characters. For each hexadecimal character, read the 
corresponding binary representation across the table.

For each ‘1’ that appears in the binary representation, drop down to the Level row to read the actual router level 
included in the mask. For example, 0AB50221 represents levels 28, 26, 24, 22, 21, 19, 17, 10, 6, and 1.

Table 7.12  Look-up table for hexadecimal to router level conversion

Hexadecimal 1st character 2nd character 3rd character 4th character

0
1
2
3
4
5
6
7
8
9
A
B
C
D
E
F

0
0
0
0
0
0
0
0
1
1
1
1
1
1
1
1

0
0
0
0
1
1
1
1
0
0
0
0
1
1
1
1

0
0
1
1
0
0
1
1
0
0
1
1
0
0
1
1

0
1
0
1
0
1
0
1
0
1
0
1
0
1
0
1

0
0
0
0
0
0
0
0
1
1
1
1
1
1
1
1

0
0
0
0
1
1
1
1
0
0
0
0
1
1
1
1

0
0
1
1
0
0
1
1
0
0
1
1
0
0
1
1

0
1
0
1
0
1
0
1
0
1
0
1
0
1
0
1

0
0
0
0
0
0
0
0
1
1
1
1
1
1
1
1

0
0
0
0
1
1
1
1
0
0
0
0
1
1
1
1

0
0
1
1
0
0
1
1
0
0
1
1
0
0
1
1

0
1
0
1
0
1
0
1
0
1
0
1
0
1
0
1

0
0
0
0
0
0
0
0
1
1
1
1
1
1
1
1

0
0
0
0
1
1
1
1
0
0
0
0
1
1
1
1

0
0
1
1
0
0
1
1
0
0
1
1
0
0
1
1

0
1
0
1
0
1
0
1
0
1
0
1
0
1
0
1

Level 32 31 30 29 28 27 26 25 24 23 22 21 20 19 18 17

Hexadecimal 5th character 6th character 7th character 8th character

0
1
2
3
4
5
6
7
8
9
A
B
C
D
E
F

0
0
0
0
0
0
0
0
1
1
1
1
1
1
1
1

0
0
0
0
1
1
1
1
0
0
0
0
1
1
1
1

0
0
1
1
0
0
1
1
0
0
1
1
0
0
1
1

0
1
0
1
0
1
0
1
0
1
0
1
0
1
0
1

0
0
0
0
0
0
0
0
1
1
1
1
1
1
1
1

0
0
0
0
1
1
1
1
0
0
0
0
1
1
1
1

0
0
1
1
0
0
1
1
0
0
1
1
0
0
1
1

0
1
0
1
0
1
0
1
0
1
0
1
0
1
0
1

0
0
0
0
0
0
0
0
1
1
1
1
1
1
1
1

0
0
0
0
1
1
1
1
0
0
0
0
1
1
1
1

0
0
1
1
0
0
1
1
0
0
1
1
0
0
1
1

0
1
0
1
0
1
0
1
0
1
0
1
0
1
0
1

0
0
0
0
0
0
0
0
1
1
1
1
1
1
1
1

0
0
0
0
1
1
1
1
0
0
0
0
1
1
1
1

0
0
1
1
0
0
1
1
0
0
1
1
0
0
1
1

0
1
0
1
0
1
0
1
0
1
0
1
0
1
0
1

Level 16 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1
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